CHUONG 2. CAC LENH VE COo BAN

2.1. Lénh vé thiét 1ip vung vé
Cac phim chirc nang thwong dung
ESC: Huy bé 1énh
Ctrl+C: ngat 1énh tré lai CommandLine
F7: déng tat ché do Grid
F8: déng tat ché do6 Orthor (ché d6 thang gbc)
F'9: d6ng tat ché dd Snap (gan bwdc nhay con tro)
Co6 dinh truc ban vé
View -> Display -> UCS Icon -> Origin
Hoac dung CommandLine: UCS



2.1. LENH VE THIET LAP VUNG VE

Thu khong gian da dwoc 2161 han vao trong man
hinh. Lénh ZOOM
& : phong to/thu nhé man hinh quan sat doi

twong
# :xem tong thé toan bo ban vé

&’ phéng to 1 khu vuwe trong hinh chit nhat

Lénh dinh don vi ban vé - units

Chirc nang: dinh don vi va don vi géc cho ban vé hién
hanh FEDraving Units 2 oirction control X
o CommandLine: Units Crm— ] [
o Format->Units... - i = o
- e
| o Cancel o) Hel




DINH GIOT HAN BAN VE - LIMITS

File->Page Setup->...
Command: Limits

ON/OFF/Lower left corner <0,0>:
ON: cho phép vé ra ngoai to gidy
OFF: khong cho phép vé ra ngoai giét han da dinh
Lower left corner: Toa do goc dwoi trai (0,0)

Upper right corner: Toa do goc trén phdi



TAO KHUNG BAN VE

Command: Mvsetup

Enable paper space? [No/Yes] <Y>:N (Chon khong gian
thwong vé nhat)

Enter units type
[Scientific/Decimal/Engineering/Architectural/Metric]: m

Enter the scale factor: Nhap ty 1€ ban vé
Enter the paper width: 297 (do rong ban vé)
Enter the paper height: 210 (chiéu cao ban vé)



Bang dinh giéi han ban vé (Limits) theo khé gidy in va ti l&

Paper size | Tilé v& 1:1 | Tilé vé 1:2 Tilé vé 1:5 Tilé vé 1:10 | T1lé vé& 1:20
(mm) Tiléeinl=1 |Tilein1=2 |Tiléin1=5 |Tiléin 1=10 | Tiléin 1=20
A4:297x210
mm | 297=210 594x420 148521050 2970x2100 5940x4200
m | 0.297x0.21 | 0.594x0.42 1.485x1.05 2.97x2.1 5.94x4.2
A3: 420x297
mm | 420x297 840x594 2100x14385 4200x2970 8400x5940
m | 0.42x0.297 | 0.84x0.5% 2.1x1.485 4.2x2.97 8.4x5.94
A2: 394x420
mm | 594=x420 1188x840 2970x2100 5940=4200 11880=8400
m | 0.594x0.42 | 1.188x0.84 2.97x2.1 5.94x4.2 11.88x8.4
Al: 841x594
mm | 841x594 1682x1188 4205x2970 8410x5940 16820x11880
m | 0.841x0.594 | 1.682x1.188 | 4.205x2.97 8.41x5.94 16.82x11.88
AD: 1189841
mm | 1189x841 2378x1682 5945x4205 11890=x8410 | 23780x16820
m | 1.189x0.841 | 2.378x1.682 | 5.945x4.205 | 11.89x8.41 23.78x16.82




CAC PHUONG PHAP NHAP TOA PO DPIEM

Dung phim chon

Toa do tuyét do1

Toa do twong do1

Toa do cuc tuyét doi

Toa do cwc twong do1

Nhip khoang cach trwe tiép



2.2. LENH VE CAC HINH CO BAN
2.2.1. Lénh LINE

Command: Line

From Point (diém dadu):
To point:

To point:

Nhdn Enter dé két thuc lénh
Go C dé co hinh khép kin
Vi du: vé hinh chit nhit ¢6 chiéu dai 120, réng 80
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THYC HANH 01

Bai thue hanh s61
Bai thwe hanh so 2
Huwéng dan:
St dung 1énh line va toa d6 cuc twong do1
Phwong phap:
Huwdéng dan truc quan



2.2.2. LENH VE DPUONG TRON — CIRCLE

Command: Circle (c)

E 64

Co6 5 cach vé duwong tron: ,ﬁ
Tam va ban kinh (Center, radius) i C
Command: c o L

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]:
(Nhdap toa do tam)

Specify radius of circle or [Diameter]: (Nhdp ban kinh)
Tam va duwong kinh (Center, Diameter)
Command: c

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: :
(Nhdp toa dé tam)

Specify radius of circle or [Diameter]: D
Specify diameter of circle : (Nhdp gia tri dwong kinh)



3 Point (3P): vé duwong tron di qua 3 diém
Command.: c

Specify center point for circle or [3P/2P/Ttr (tan tan
radius)/: 3P

Specify first point on circle:
Specify second point on circle:

Specify third point on circle:
2 Point (2P): Vé dwong tron di qua 2 diém
Command: c

Specify center point for circle or [3P/2P/Ttr (tan tan
radius)]: 2P

Specify first end point of circle's diameter: (

30

Specify second end point of circle's diameter::




DPuwong tron tiép xac 2 doi twong va ¢6 ban kinh R (TTR)
Command: c
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: TTR
Specify point on object for first tangent of circle:
Specify point on object for second tangent of circle:
Specify radius of circle:
Dwong tron ti€p xac 3 do1 twong
Command: c
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 3p
Specify first point on circle: TAN
to (chon dt thiwr nhdt cdan tiép xtc)
Specify second point on circle: TAN
to (chon dt thitr hai cdn tiép xtc)
Specify third point on circle: TAN
to (chon dt thir ba cdn tiép xtc)

tan, tan, radius “




2.2.4. LENH VE CUNG TRON ARC

Vé cung tron di qua 3 diém
Command: A (Arc)
ARC Specify start point of arc or [Center]:
Specify second point of arc or [Center/End]:
Specify end point of arc:

Di1ém diu, tam, diém cudi (start, center, end)

Command: A (Arc)

Specify start point of arc or [Center]/:

Specify second point of arc or [Center/End]: c
Specify center point of arc: xac dinh toa do tam
Specify end point of arc or [Angle/chord Length]:



Di1ém diu, tam, chiéu dai day cung (start, center,
Length of chord)
Command: A (Arc)
Specify start point of arc or [Center]:
Specify second point of arc or [Center/End]: c
Specify center point of arc: xac dinh toa do tam
Specify end point of arc or [Angle/chord Length]: |
Specify length of chord: xac dinh chiéu dai day cung



2.2.5. LENH VE DA GIAC PEU POLYGON

Pa giac ngoai tiép dwong tron: khi cho trwéc tam va ban
kinh (khodng cach tir tam dén diém gitra ctia canh)
Command: polygon
Enter number of sides : nhdp sé canh da gidc
Specify center of polygon or [Edge]:

Enter an option [Inscribed in circle/Circumscribed about circle]
<[>:c

Specify radius of circle: (Nhdp gia tri ban kinh dwong tron néi tiép)



2.2.5. LENH VE DA GIAC PEU POLYGON

Pa giac no1 ti€p duwong tron: khi cho truwéce ban kinh
dwong tron ngoai ti€p (khodng cach tir tam dén dinh)
Command: polygon
Enter number of sides :
Specify center of polygon or [Edge]: nhdp s6 canh da gidc
Enter an option [Inscribed in circle/Circumscribed about
circle] <I>: 1
Specify radius of circle: (Nhdp gia tri ban kinh dwong tron
ngoai tiép)




2.2.5. LENH VE DA GIAC PEU POLYGON

Nhap toa do 1 canh cua da giac
Command: polygon

Number of sides <4>: (Nhdp sé canh)
Edge/<Center of polygon>: E

Firsts endpoint of edge: (nhdp toa dé diém ddu mot
canh)

Second endpoint of edge: (nhdp toa dé diém cudi mot

canh) r
| \j



2.2.6. LENH VE DA TUYEN PLINE |
Ché do vé doan thang

Command: Pline

From point:

Current line width is <0.00>: (chiéu rong hién hanh cta Pline la 0)

Specify next point or [Arc/Halfwidth/Length/Undo/Width]: toa dé diém ké

tiép

Cac lua chon:

+ Close: déng Pline b1 mot doan thang

+ Halfwidth: dinh ntra chiéu réong phan doan sap vé
Starting Half width <current>: (gia tri nira chiéu réong ddu phan doan)
Ending Half width <current>: (gid tri ntta chiéu réng cudi phan doan)

+ Length: vé doan Pline c6 phwong chiéu nhw doan thang trudce dé

Length of line: chiéu dai doan sdp vé



CHE DO VE CUNG TRON

Command.: Pline

From point:

Current line width is <0.00>: (chiéu réng hién hanh cia Pline la 0)
Arc/Close/Halfwidth/Length/Undo/Width/ <Endpoint of line>: A

Angle/CEnter/Close/Direction/Halfwidth/Line/Radius/Second
pt/Undo/Width/<End point of arc>:



CHE DO VE CUNG TRON

Cac lva chon:
+ Close: dong da tuyén bé1 mot cung tron
+ Angle: twvong tw nhuw 1énh vé Arc
Included angle: gia tri goc o tam
+ CEnter: khi nhip CE xuat hién
Center point: toa do tam
+ Direction: dinh hwéong dwong ti€p tuyén vol
diém dau tién cia cung tron
+ Radius: ban kinh cung
Radius: nhdp ban kinh cung
Angle/<Endpoint>: nhdp géc ¢ tam hodc
diém cudi cung tron
+ Second pt: nhip toa d6 diém th 2 va diém
cudl (cung tron qua 3 diém)
+Line: tr& vé ché do vé doan thang

radius
.

o3

.



2.2.7. LENH TRIM'E

Cho phép xén, tia mdt doan thang cia do1 twong

dwoc g161 han béd1 mdt hay nhiéu do1 twong khac

Khi xén phai lam theo thir tw tir mot phia

Poan cuodi cung khong thé Trim ma phai Delete
Command: Trim

Select objects: (Chon doi twong)
Select objects:

(Nhdn enter dé két thuc viéc chon)

Select object to trim or [Project/Edge/Undo]: (Chon
doan cdn xén bé va Enter két thuc lénh)



2.3. CAC PHUONG THUC TRUY BAT DIEM OSNAP

Cho phép truy bat cac diém thudc doi twong nhw: diém
cuol, diém giira, tam, giao diém,...

Céac diém ddc biét

. 2 e Lénh Biéu
Diém Dac Bigt Truy Bdt | tugng
Obiém ddn/cud
(Diém ¢ 2 dau cila doan thdng, cung tron)
e 1 .
E/E E‘_\I Endpoint END O
L £l ﬂ
@Dbiém giiia
( Trung diém ciia doan thdng, cung trén, canh HCN, canh da gidc)
= Midpoint MID
/ ’—’Q\ & lil
@biém tim
(Diém & tam cila dudng tron, cung tron, élip)
\ Center CEN
©
D




CAC DIEM DAC BIET

@Diém dinh % (gdc %)
( Diém tai cdc goc 0°, 90°, 180°, 270° cila dudng tron, cung tron. élip)

O @ Q R
®Ppi€m giao nhau (cdt nhau)
(Giao diém ciia 2 do1 titong)
Intersection INT X
X
®biém kéo dai
( Diém kéo ddi ciia doan thdng, cung tron)
Extension EXT




CAC DIEM DAC BIET

@Diém vudne goc
(Diém vuéng goc cia 2 do61 tuong)
Perpendicular PER G
Y
®Di€m ti€p xiic
- { Diém tiép mic ciia 2 d61 nwong)
= Tangent TAN
5 ©
®Diém song song
(Diém thii 2 dé tao duwong song song)
__________ +.. Parallel PAR I
Ve
@ piém tham khio
( Diém 5é ldm géc toa dd tam thoi cho diém ké'tiép)
= &
Bzaze Point “Offeet: @Lao From FRO

Iy




THAO TAC TRUY BAT DIEM

AutoCAD yéu ciu nhip toa do diém can vé
Nhap 1énh truy bat twvong ng (END, MID,
CEN,...)
D1 chuyén tré chuot dén gan diém dac biét can
truy bat -> xuit hién biéu twong can truy bat
Nhap trai chudt
Luu y:

Lénh truy bat phai nam trong mot 1énh vé

C6 thé dung Shift + phai chuot dé hién danh sach cac
diém ddc biét va chon thay cho g6 1énh

Vi du: Vé hinh thang ABCD =0




Bude 1: Vé hinh thang lén ABCD:
Convnand: LINE.J

Specify first point: (bfim trdai chudt tgi vi tri bt k¥ trén msin hinh)

Spectiy nexdt point or [Unde ] @20,604
Spectiy next point or [Undoe]: @120<0
Speciiy next point or [Close/Undo J: @ 20,-60.]

Specify next point or [ Close/Undo]: @160<180. B e
Spectiv nexdt point or [Close/Undo]: J /
Bude 2: Ding MID vé dudng giia GH: v [ F . B |
Command: LINE.J A H D
Specify first point: MID . . = -
of (ding chujt truy bdt difém G) Budc 3: Ding FROM vé duirng xién bén trong EF:

Specify next point or [Undo]: PER.J
to (diing chudt truy bdt diém H)
Spectfy next point or [Close/UndoJ: J

Command: LINE.J

Specifv first point: FRO.J

Base point: END.J

of (ding chu§t truy bdt difm B)

= (hfset=: @30,0J

Specifv next point or [Undo J: FROJ
Base point: INT

of (diing chujt truy bdt diém A)

= (Mfset=: @40,0.]

Specifv next point or [Close/Undel:

Budc 4: Ditng FROM vé dudng xién bén trong IJ: (lim tudng e butdc 3 nhung truy bt di€ém G & H)



CAI PAT Ty PONG TRUY BAT DPIEM DAC BIET

Nhén F3 hode
bém trdi chudt vdo
ddv dé Bgt/Tat

GRID| ORTHO| POLAR[OSNAF OTRACK] LwT([MODEL

Bam phail chugt vdo

ady ﬂfé‘e £hu|_1'.'-lﬂ S-Efﬁﬂ 1

a thiét lap cde tru
bdt tir dong

%= Drafting Settings

Snep and Ged | Poler Tr.:rk_np'- Clleecl EIFrEI.E

Object Snap On F3) Dbject Soa Tracking On (F11)

DObfect Shap modes

O @ Endport B [ ingstion 'E
2 [#] Midpon b [FlEeperdicus [ Ol
0 [#] Contes o [ Tangem

= [Node = [INeaps

¢ [ Guackant [ [ Apparent inkerzechion

M [#] Intersecton . [ Paskel

=[] Extension

1 To track fram an [snap part, pauze over the port while m 3
& cammand A backing vector sppears when pou move the cuman
To #top hacking, pawss over the point again.

L oe || Cacel || Hew
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2.4. LENH GHI VA HIEU CHINH VAN BAN

4.2.1. Tao kiéu chir tiéng Viét - STyle
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2.4. LENH GHI VA HIEU CHINH VAN BAN

2.4.2. Lénh MTEXT — Nhap van ban vao ban vé
Command: Mtext

Dé thay doi1 style chit: Format -> Text Style

Text Style E
Style Name
Apply
MNew... R Drelet
shyle W =0 £name elete
Fart Help
Fant Mame: Fant Style: Height:
T Verdana W Fegular W 2.0000
I1ze Big Font
Effects Preview
[ Upside down “width Factgr: | 1.0000
[]Backwards Oblique ngle: |0 Aa B bc C D
Wertical AaBbCeD Frevien

2.4.2. Lénh MTEDIT — Hiéu chinh van ban
Command;: MTEDIT
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Hinh 2: Khung tén hoc tdp — nganh co khi
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